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HEC-EFMSim Workshop 

Simulation of Stationary and Mobile Communities 

Objective 

In this workshop, you will use EFMSim to investigate spatial and temporal aspects of 
stationary and mobile ecological communities.   

Background 

EFMSim is a new software tool that uses spatial and temporal data layers to predict changes 
in ecological communities.  It allows modelers to test the effects of land management 
practices, water management decisions, water quality concerns, and any other spatial and 
temporal variable of interest.   

Simulating ecosystems in time and space is complicated.  The following steps are needed to 
apply EFMSim: define study area, create layouts by splitting study area into collections of 
elements, import data, create variables based on data, define communities, create rules to 
govern communities, and, finally, simulate and view results.  In the interest of time, several 
of these steps have been done for you. 

This workshop focuses on four ecological communities of interest: Cottonwood trees - a key 
tree species for western riparian forests, Delta smelt - an endangered species of fish that 
inhabits a stretch of river being considered for restoration, and a prey-predator simulation 
showing the interaction of rabbits and grass. 

Part 1 of this workshop focuses on cottonwood recruitment.  Part 2 investigates delta smelt 
movement. Part 3 involves two communities – grass and rabbits. 

Part 1: Simulating Stationary Ecological Communities 

In this part of the workshop, you will define the communities to be simulated, the rules that 
govern their behavior, run the simulation and analyze results.  The define study area, layout 
setup, data import and variable creation steps have already been completed.   

Getting Started 

Open the project and review the information that has already been entered. 

Open HEC-EFMSim. 

Use the “File | Open Project” menu option to open an HEC-EFMSim project named 
Cottonwood_2020.prj.  It is located at 
C:\Workshops\EFMSim\Cottonwood_2020 (or in a location determined by the 
workshop facilitator). 
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 To open the layout interface… 
 Click the Layouts button on the left hand side of the interface (or select the 

“Windows | Layouts | All” menu option if the button is not visible). 
 The outline of the Study Area should be visible.  In the Layout Map tab, navigate to 

the “Layouts | Open” menu option. 
 Select Layout1 and click OK. 
 Use the Zoom tool to get a better look at the Study Area (left click and drag a 

window to zoom in and right click to zoom out). 
 

Note: The river riparian zone is parsed into a grid of 45’x45’, while the more upland 
terrestrial area has a 90’x90’ grid.  

 
 
 

 Data interfaces are comprised of: Data Import tables, Data Controls, and Create 
Variables… 

 
 Click on the yellow-green Data button on the Control Panel (usually on the left-

hand side of main interface). 
 

 Review the contents of the Data Import tables… 
 

  “Elevation” is a constant data set of topography for the study area.  
 

 “WSE_today” and “WSE_yesterday” are regular data sets comprised of daily 
simulated water surface elevations produced by an unsteady river hydraulics model.   

 
Note: Data Import tables allow users to import the spatial and temporal data to be used in 
simulations.  EFMSim can import data sets that do not change with time (i.e., “constant”), 
change sporadically with time (i.e., “irregular”), or are available at each time step (i.e., 
“regular”). 
 

 Review settings in the Data Controls tab… 
 

 A data controls set named “Centroid” has been created with the centroid option 
selected for both raster and feature class data. 

 
Note: Data Controls determines how imported data are snapped to elements in the model 
layout.  For example, the centroid option assigns values to elements based on the data 
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value that occurs at the centroid of each element. The interface also allows users to specify 
different methods for individual data sets via exceptions. 
 

 Review settings in the Create Variables tab… 
 

 The “depth_today” and “depth_yesterday” variables have been created using the 
variable calculator and will be explained in the following sections. 

 
Note: Create Variables allows modelers to make variables based on imported data sets.  
These variables are then available when defining rules for communities.  This is useful when 
community dynamics are indirectly related to imported data (eg, a species of plant may 
need to be inundated for more than one day before it is stressed or experiences mortality). 
 
With layouts and data tasks complete, we are ready to begin entering ecological info.  This 
is actually an important transition during EFMSim applications.  It marks the point at which 
it makes sense to tell the software to “Prepare for Simulation”.  When this command is 
issued, the software will populate its database with the values needed for simulation.  
Processing time is proportional to the number of elements in each layout as well as the 
amount of data imported and variables created.  For the purposes of this workshop, the 
project has already been prepared for simulation.  

Making Communities and Using Rules 

Next, use the Community interfaces to create the Cottonwood community and size classes 
and then use the Logic interfaces to define recruitment and growth rules for Cottonwoods.  
In riparian areas, cottonwood seedlings begin to grow in areas of newly exposed river 
substrate.  We will use this information to define a recruitment rule that initiates seedlings 
in areas that were wet yesterday and are dry today. 
 

 To define the Cottonwood community… 
 Click on the green Communities button on the left… 
 Select the Communities tab. 
 Input the following information into the Communities table. 

o Name: Cottonwood 
o Level: 0 
o Size Variable: height 
o Size Units: feet 

 
 

 Click on the Define Size Class tab.  
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 Next, define three cottonwood size classes by first left-clicking to highlight the 

Cottonwood community name then right-clicking and selecting Add Class.  

 
 
o Add three size classes: Seedling, Juvenile and Mature with size class lower 

limits of 0.1, 1.0, and 10.0, respectively. (Hint: Double-click the added class to 
rename and enter the lower limits).   

 
 

 To define rules for the communities… 
 Click the green Logic button on the left… 
 Select the Recruitment Rules tab. 

o Create a new recruitment rule named Recruit_Cottonwood by clicking the Add 
Rule  button. 

o Assign the Cottonwood community by selecting it from the dropdown list. 
o The recruitment season should start on 05Jan and end on 27Jan. 
o In the Data/Variables: Rasters table, input the following data.  In the second 

column click the cell to use the Variable Picker  (or double-click the cell) to 
select the variables “depth_today” and “depth_yesterday”. Use the  button to 
add another line of input. 
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o Under the Expression Builder, input 

the following equation.   
Type carefully… 
there is a space on each side of the 
double “&&”.  Variables and syntax must 
match exactly.  

 
o Finally, click the Apply button on the bottom right hand side of the frame. 

 
 Select the Growth Rules tab (may need to scroll                                      ). 

o To create a new growth rule, named Grow_Cottonwood, click Add Rule .  
o Choose the Cottonwood community from the drop-down list. 
o Next, right-click in the empty space below the Seedling tab and select Insert 

Row(s)… and select 1 and click OK. 
o Use 07Jan to 28Jan for the timeframe. 
o Name the rule Grow_Seedling. 
o Select the Equation radio button and use the buttons to the right to input 

CommClass.current("Cottonwood","Seedling", "Size")+0.1.  The VAR 
button will allow you to pick a variable to insert.  Click on the VAR button. Select 
Cottonwood – Seedling from the Category drop-down menu and select Size 
from the Member drop-down menu. Then click OK. Then use the buttons to 
enter “+0.1” in the Equation window. Note: Please be sure to include the “0” in 
“0.1”. 
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o Click the Set Value button to assign the equation you just entered into the Value 

field.   

 
 
Repeat these steps for the Juvenile and Mature size classes using similar names 
and values of: 
CommClass.current("Cottonwood","Juvenile", "Size")+0.5 and 
CommClass.current("Cottonwood","Mature", "Size")+1.0. 

o Select the Apply button when you are finished.  

Creating Alternatives and Simulations 

With the rules complete, the next step is to build the alternative and simulation to be 
performed. 
 

 Use the pink Scenario Builder button on the left to access the Alternatives tab. 
 Make an alternative named AltCottonwood, choose the Cottonwood community 

(click Edit to open the Select Communities window) and select the layout and data 
control set discussed earlier.  

 

 
 
Now you are ready to simulate… 
 

 Select the “View | Simulation” menu option from the top menu bar. 
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 Right-click on the Simulations 
tree, select New Simulation, 
and create a new simulation 
named SimCottonwood with 
a start date of 02Jan2011, an 
end date of 29Jan2011 and a 
ONE_DAY time step. Click 
OK.  

 
 
 
 

 Expand  the Simulations tree, 
right-click on SimCottonwood. 

 Uncheck the Create Shape 
Files option, and select Add 
Alternative, highlight 
AltCottonwood, and click OK. 

 
 To compute, right-click the 

SimCottonwood simulation and 
select Compute All. 

 
 To view the progress of the 

simulation, click on the 
Simulation tab in the Output 
tab at the bottom of the screen. If the Output tab is not visible, navigate to View | IDE 
Log and it should appear at the bottom of the screen. 

 
 Once the simulation is done, we must make the alternative active to view the results.  

To make the AltCottonwood alternative active, right-click on it and select Set Map.  A 
red dot should appear next to the active alternative. 
 

 Click the View Animation button 
(located at the bottom of the Simulation 
tab) to access the Animation Controls 
window. 
 

 From the Layer Selection tab, right-click 
on the Animation-Standard-Cottonwood-
Size layer and click Properties from the 
shortcut menu. 
 

 From the Properties dialog from the 
Properties tab, in the Contour Limits 
panel uncheck the "System Specified 
Min/Max Values" option. Enter a 
Maximum of 10.0 and keep the Minimum 
at 0.1. Click OK. 
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 Hit the play button and watch your Cottonwoods recruit and grow.  The last simulated 
condition should look like this. (Hint: to add the legend, from the Simulation Map 
window, select the “Simulations | Show Legend” menu option). 

 

 
 

 Right-click the Alternative, 
AltCottonwood, and select Plot 
Size.   

 

 

 
 

 Use the animation and size plot to answer the following questions.  
 

 How tall did the Cottonwoods get? 
 
 

 Why did the Max Size series change slope on 15Jan? 
 
 
 

 Why is the Average Size series different than the Max Size series? 
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Part 2: Mobile Ecological Community Simulation 

 In this part of the workshop, you will define rules that govern how a community named 
“delta_smelt” moves, run multiple simulations and analyze results.  The study area, 
layout, data import, community definition and recruitment rule steps have already been 
completed. Further, an alternative and simulation has been created and run which 
recruits smelt as a stationary community. You will add a mobility component to the 
community simulation by creating three simulations: movement, movement through a 
medium and movement through a medium with density rules. 

Getting Started 

 Close HEC-EFMSim and then reopen the software                (this step is needed to 
clear the Cottonwood project). 

 
 Use the “File | Open Project” menu option to open a project named 

Delta_Smelt_2020.prj.  It is located at 
C:\Workshops\EFMSim\Delta_Smelt_2020 (or in a location determined by the 
workshop facilitator). 
 

 Feel free to review the Data, Communities, and Logic interfaces.  To summarize, a single 
constant elevation data set was imported.  The delta_smelt community recruits on 
March 4th of each year based on elevation (this has no ecological basis; it is done only to 
create a community to move). 

Simulating Movement 

 To open the layout interface… 
 

 Click the Layouts button on the left hand side of the interface (or select the 
“Windows | Control Panel” menu option if the button is not visible). 

 The Study Area and Stream Region should be visible.  In the Layout Map window, 
navigate to the “Layouts | Open” menu option. 

 Select Layout2 and click OK. (If Layout2 is already open select the appropriate tab). 
 Use the Zoom tool to get a better look at the Study Area (left click and drag to zoom 

in and right click to zoom out). 
 

 Click the green Communities button to access the Communities tabs. 
 

 In the Movement tab, input the following parameters to define the physical 
movement capabilities of delta_smelt.  
o Community: delta_smelt 
o Size Class: ..All.. 
o Unit: meters/hour 
o Variable: Elevation (selected from the Variable Picker dialog) 
o Interpolation: Linear 
o In the table, fill in -20, 0 and 20 (in the Variable Value column) and a constant 

15.0 (in the Maximum Community Velocity column).  
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o Be sure to hit the Apply button when you are finished. Note, the Apply button is 
located at the bottom of the Movement tab, maximize the HEC-EFMSim main 
window to access the button if it is off the screen. 

 

 
 

 In the Units Manager tab, make sure that, under Density project unit, the 
Community To Project cell has a value of 1. If it does not, enter a value of 1 and 
click Apply. 
 

 
 

 Now, click on the green Logic button on the left. 
 In the Instinctual Rules tab (if necessary, use the navigation arrows (  or  to find 

the tab), make a new rule  named Smelt_Instinct.  
o Assign the delta_smelt community and the Adult size class. 
o To identify where the smelt will want to move, enter in the following text under 

Location (WKT):  POINT (630617 4222976) 
o In the Strength (Function of Season) panel, enter the following dates and 

factors. 

 
 
o Enter in 1.0 for the Weight, Linear for Dissipate, 500000 Map units for the 

Radius.  
o Double-check all above information has been entered correctly and click Apply. 
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 Navigate to the Simulation module by clicking the “View | Simulation” menu option. 

 
Note: A simulation named Smelt_Recruit, which recruits smelt as a stationary community, 
has already been run. 

 
 Right click on the Simulations tree, select New Simulation, and create a new 

simulation named Smelt_Move with a start date of 01Mar2011, an end date of 
31Mar2011 and a ONE_DAY time step. 

 
 
 Expand the Simulations tree, right click on Smelt_Move,  uncheck the Create 

Shape Files option, and select Add Alternative, highlight AltSmelt, and click OK. 
 To compute, right-click the simulation and select Compute All. 
 Once the simulation is done, make the AltSmelt alternative active by right-clicking 

on it and selecting Set Map.   
 Click the View Animation button to access Animation Controls and view the 

animation. 
 

 To predict the way a community will move when ecological factors affect their choices, 
attraction layers can be generated to show the probable direction of movement. 

 

 Based on the location of the element assigned in the Instinctual Rule, what do you 
imagine the Instinctual Attraction Layer will look like? 
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 To view the Instinctual Attraction 

Layer, from the Layer Selection tab, 
right-click on the Animation layer 
under the Layer Selection tab and 
select Properties. 

 
 
 

 In the Properties interface select the 
Simulation radio button and choose 
Standard and the delta_smelt - 
Adult community. Next, select the 
Attraction Layer radio button and 
choose Instinctual Rule Total. Click Apply. Click OK. 

 

 
 

 From the Simulation tab, click the View Animation button and play the animation 
to see the attraction layer.  

 Right-click on AltSmelt (under the Smelt_Move simulation) and select Plot 
Density. 

 
 Use the animation and corresponding density plot to answer the following: 

 
 When do most of the smelt make it to the location of instinctual attraction? 
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Movement Through a Medium 

 Select the “Windows | Communities | All” menu option to open the Movement tab. 
 

 In the Movement tab, from the Medium that attraction works through and 
suitabilities panel, select the following from the dropdown lists.  
 
o Region Map: Regions 
o Region: River 
o Interaction of …: Weighted Average (density given priority)  
o Make sure to hit the Apply button when you are finished. 

 

 
 

 Now we are ready to simulate movement through a region.  Go to the Simulation 
module by clicking the “View | Simulation” menu option. 

 
 Right click on the Simulations tree, select New Simulation, and create a new 

simulation named Smelt_Move_Region with a start date of 01Mar2011, an end 
date of 31Mar2011 and a ONE_DAY time step. 

 Expand the Simulations tree, right click on Smelt_Move_Region, select Add 
Alternative, highlight AltSmelt, and click OK. 

 
 To compute, right-click the simulation  uncheck the Create Shape Files option, 

and select Compute All. 
 Once the simulation is done, make the AltSmelt alternative active by right-clicking 

on it and selecting Set Map.   
 Click the View Animation button to access Animation Controls and view the 

animation. 
 

 Right click on AltSmelt and select Plot Density.   
 

 Use the animation and corresponding density plot to answer the following: 
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 What do you think the instinctual attraction layer will look like now? When do most of 
the smelt make it to the location of instinctual attraction?  How does this differ from 
the Smelt_Move simulation?  Why? 

 
 
 
 
 
 
 
 
 

 According to the Density plot, what is the maximum density at the end of the 
Smelt_Move_Region simulation? 

 
 
 
 

 

Part 3: Simulating Interactions between Ecological Communities 

In this part of the workshop, you will define rules that govern how two communities named 
“Grass” and “Rabbits” interact and analyze results. The study area, layout, data import, 
prepare for simulation, community definitions, and recruitment and growth rules have 
already been completed. A simulation has already been created called “Rabbits_Grass” for 
which you will create five alternatives: foraging with a small radius, foraging with a 
larger radius, consumption by true predation, consumption by browsing, and consumption 
by browsing only seedlings. A recruitment alternative has already been created and run. 

Getting Started 

 Close HEC-EFMSim and then reopen the software                                 (this step is needed to 
clear the Delta Smelt project). 

 
 Use the “File | Open Project” menu option to open a project named 

Rabbits_Grass_2020.prj.  It is located at 
C:\Workshops\EFMSim\Rabbits_Grass_2020 (or in a location determined by the 
workshop facilitator). 

 
 Feel free to review the Data, Communities, and Logic interfaces.  To summarize, a single 

constant elevation data set was imported.  The Grass community recruits from January 
5th to January 9th of each year based on elevation and the seedlings and adults grow at 
constant rates of 0.10 and 0.01 per time step, respectively. The Rabbit community 
recruits on January 10th of each year based on elevation and movement capabilities have 
also been defined.  
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 To open the layout interface… 
 

 Click the Layouts button on the left hand side of the interface (or select the 
“Windows | Layouts | All” menu option if the button is not visible). 

 The outline of the Study Area should be visible.  In the Layout Map tab, navigate to 
the “Layouts | Open” menu option. 

 Select Layout1 and click OK. 
 Use the Zoom tool to get a better look at the Study Area (left click and drag to zoom 

in and right click to zoom out). 

Creating Project Units 

 Click the green Communities button to access the Communities tabs. 
 

 In the Units Manager tab, click the Add Project Unit button and enter Biomass 
for the Name and oz for the Units. Click OK. 

 
 

 Input the following parameters to define the Density and Biomass Project units of 
Rabbits and Grass. Use the Edit Equation  button (you must click inside of a cell to 
make this button appear) and the Variable Picker VAR (this gives you the $CU and 
$PU functions) to fill in these equations. Click Apply. 

 

Foraging with a Small Radius 

 Click the green Logic button on the left to access the Logic tabs. 

 In the Forage Rules tab, create a new rule  called Rabbit_Forage. 
 

o Assign the Rabbits community and the Bunnies size class. 
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o In the Pick Forage for Community-Class panel, highlight the 0 folder, under 
the Project folder, and click Add>> to add the Grass community to Forage. 

 
 

o From the Forage Units dropdown, select Biomass. 
 

o From the Strength (function of forage and season) panel: 
 In the Forage – Strength (-1 to 1) table, right-click in the Forage cell and 

select Insert Row(s)… then enter 5 and click OK.  
Fill in the following 
values: 

 
 
 In the Date – Factor (0 to1) table, right-click in the Date cell and select 

Insert Row(s)… then enter 3 and click OK. 
Fill in the following 
values: 

 
 

o Enter a weight of 1.0, Linear for Dissipate, 200 Map units for Radius and click 
Apply. 

 
 Now we are ready to create a new alternative for the Forage Rule we just made. 

 
 Click on the pink Scenario Builder button on the left to access the Alternatives tab. 
 Make a new alternative by clicking the  button. Name the alternative Forage, 

choose both the Rabbits and Grass communities, select Layout1, and select 
Centroid. 

 
 

 Navigate to the Simulation module by clicking the “View | Simulation” menu option. 
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Note: A simulation named Rabbits_Grass, which has an alternative that recruits rabbits 
and grass as stationary communities, has already been run. This simulation has a start date 
of 01Jan and an end date of 28Feb and uses daily time steps. 
 

 From the Simulation tab, expand the Simulations tree, right-click on 
Rabbits_Grass, make sure the Create Shape Files option is unchecked  and 
click Add Alternative from the shortcut menu, highlight Forage, and click OK. 

 
 To compute, expand 

Rabbits_Grass simulation and 
right-click the Forage 
alternative and select 
Compute.  
(Do NOT compute all) 

 
 Once the simulation is done 

computing, make the Forage 
alternative active (right-click 
and select Set Map).   
 

 Click the View Animation 
button to view the animation 
and access Animation Controls. 

 

 
 

 To view the progress of both 
communities at the same time, click on 
Simulations in the viewing port and 
select New Simulation Window. 
 

 A new tab should appear with a 
duplicate window of the simulation. 
Drag this tab down to the lower half of 
the simulation window until a 
red/orange split screen box appears 
telling you where to drop it. 

 

 
 

 

 

W5.2/161



 

HEC-EFMSim Workshop  18/23 

 
 Now you can assign each community to a simulation window by clicking on each 

simulation tab in turn and going to the Animation layer found in the Layer 
Selection tab. Right click on Animation and select Properties to assign a 
community to that simulation tab.  

 
 To view plots for any part of the communities, click and drag the cursor over the 

area of interest and right click in that space to select the plots. 
 

 
 

 Use the animation and corresponding count plot to answer the following: 
 
 How many rabbits moved from their original recruitment position? Why didn’t the 

entire community move? 
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Foraging with a Large Radius 

 Select the “Windows | Logic | All” menu option. 
 

 In the Forage Rules tab, make sure that the Rabbit_Forage rule you created 
earlier is still selected and change the Radius to 500 Map units. Click Apply. 
Everything else should remain the same. 

 
Now we are ready to create a new alternative for the Forage Rule we just changed. 
 

 Click on the pink Scenario Builder button on the left to access the Alternatives tab. 
 

 Make a new alternative by clicking the  button. Name the alternative Forage Big 
Radius, choose both the Rabbits and Grass communities, select Layout1, and 
select Centroid. 

 
 Navigate to the Simulation module by clicking the “View | Simulation” menu option. 

 
 Expand the Simulations tree, right click on Rabbits_Grass, select Add Alternative, 

highlight Forage Big Radius, and click OK. 
 To compute, expand Rabbits_Grass and right-click the Forage Big Radius 

alternative and select Compute. 
 

 Once the simulation is done computing, make the Forage Big Radius alternative 
active by right-clicking on it and selecting Set Map.   

 This animation is better viewed side-by-side with the smaller radius alternative. This 
can be achieved by clicking on the top simulation’s tab and making the Forage Big 
Radius alternative active in that window. Do the same to the bottom simulation but 
make the Forage alternative active. Make sure for each simulation window the 
Rabbits-Bunnies-Size animation layer is active in the Layer Selection tab. If it is 
not, right click on the Animation layer and select Properties to change 
communities. 

 Click the View Animation button to access Animation Controls and view the 
animation. 

 
 To view plots for any part of the communities, click and drag the cursor over the 

area of interest and right click in that space to select the plots. 
 

 Use the animation and corresponding count plot to answer the following: 
 
 How many rabbits have now left their original recruitment position?  
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Consumption by True Predation 

 Select the “Windows | Logic | All” menu option. 
 

 In the Consumption Rules tab, create a new rule  named 
Rabbit_Consumption. 

 
 Assign the Rabbits community and the Bunnies size class. 

 
 In the Define How Much is Eaten panel, select the Constant Rate radio  button 

and enter a value of 0.015. 
 

 In the Define Efficiency of Consumption panel, enter the following: 
o Consumption Units: Biomass 
o Consumption Efficiency: 0.02 
o Consumption Type: Predation 

 
 

 In the Define What is Eaten First panel, click on the Evenly distributed per % 
lumped and available forage radio  button. 

 
 Click Apply. 

 
Now we are ready to make a new alternative for the Consumption Rule we just created. 
 

 Click on the pink Scenario Builder button on the left to access the Alternatives tab. 
 

 Make a new alternative by clicking the  button. Name the alternative True 
Predation, choose both the Rabbits and Grass communities, select Layout1, and 
select Centroid. 

 
 Navigate to the Simulation module by clicking the “View | Simulation” menu option. 

 
 Expand the Simulations tree, right click on Rabbits_Grass, select Add Alternative, 

highlight True Predation, and click OK. 
 To compute, expand Rabbits_Grass and right-click the True Predation alternative 

and select Compute. 
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 Once the simulation is done computing, make the True Predation alternative active 
by right-clicking on it and selecting Set Map.   

 Click the View Animation button to access Animation Controls and view the 
animation. 

 This animation should be viewed with both the Rabbits and Grass communities 
visible on a split screen so the effects of predation can be seen in both communities 
at the same time. 

 Use the animation and corresponding plots to answer the following: 
 
 What were the maximum and average grass sizes at the last time step? 

 
 
 
 What were the maximum and average rabbit sizes at the last time step? 

 
 
 
 How many rabbits were left in the western part of the simulation plot? Why do you 

think they were cut off from the rest of the community? 
 
 
 
 
 If the simulation were allowed to continue, what do you think would happen to the 

remaining grass? How would this effect the rabbit community? 
 
 
 

Consumption by Browsing 

 Select the “Windows | Logic | All” menu option. 
 

 In the Consumption Rules tab, select the Rabbit_Consumption rule you created 
earlier and change the Consumption Type to Browsing for both the Rabbits and 
Grass communities. Click OK.  

 
 

 Everything else remains the same for the Consumption rule. Click Apply. 
 
Now we are ready to make a new alternative for the Consumption Rule we just changed. 
 

 Click on the pink Scenario Builder button on the left to access the Alternatives tab. 
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 Make a new alternative by clicking the  button. Name the alternative Browsing, 
choose both the Rabbits and Grass communities, select Layout1, and select Centroid. 

 
 Navigate to the Simulation module by clicking the “View | Simulation” menu option. 

 
 Expand the Simulations tree, right click on Rabbits_Grass, select Add Alternative, 

highlight Browsing, and click OK. 
 To compute, expand Rabbits_Grass and right-click the Browsing alternative and 

select Compute. 
 Once the simulation is done computing, make the Browsing alternative active by 

right-clicking on it and selecting Set Map.   
 Click the View Animation button to access Animation Controls and view the 

animation. 
 This animation is better viewed side-by-side with the True Predation alternative. 

This can be achieved by creating four simulation windows and switching two windows 
to one alternative and two windows to the other alternative. Each of the two 
windows could then be assigned a different community.  

 Use the animation and corresponding plots to answer the following: 
 

 What were the maximum and average sizes of the Grass community at the last 
time step? Are these values different from the True Predation values? Why or why 
not? 

 
 
 

 What were the maximum and average sizes of the Rabbit community at the last 
time step? Are these values different from the True Predation values? Why or why 
not? 

 
 

Consumption by Browsing Only Seedlings 

 Select the “Windows | Logic | All” menu option. 
 

 In the Forage Rules tab, select the Rabbit_Forage rule you created earlier. 
 

o In the Pick Forage for Community-Class panel, highlight the 0 folder under 
the Forage folder and click <<Remove. 

o Now expand the 0 folder and just highlight the Seedlings size class. Click on 
Add>> to add the Seedlings class to the Forage folder. 
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o All other data remains the same in the Forage rule. Click Apply. 
 
Now we are ready to make a new alternative for the Forage Rule we just changed. 
 

 Click on the pink Scenario Builder button on the left to access the Alternatives tab. 
 

 Make a new alternative by clicking the  button. Name the alternative Browsing 
Seedlings, choose both the Rabbits and Grass communities, select Layout1, and 
select Centroid. 

 
 Navigate to the Simulation module by clicking the “View | Simulation” menu option. 

 
 Expand the Simulations tree, right click on Rabbits_Grass, select Add Alternative, 

highlight Browsing Seedlings, and click OK. 
 To compute, expand Rabbits_Grass and right-click the Browsing Seedlings 

alternative and select Compute. 
 Once the simulation is done computing, make the Browsing Seedlings alternative 

active by right-clicking on it and selecting Set Map.   
 Click the View Animation button to access Animation Controls and view the 

animation. 
 This animation is better viewed side-by-side with the Browsing alternative. This can 

be achieved by creating four simulation windows and switching two windows to one 
alternative and two windows to the other alternative. Each of the two windows could 
then be assigned a different community.  

 Use the animation and corresponding plots to answer the following: 
 

 How does browsing only seedlings differ from browsing all size classes? Does the 
average grass size differ from the other simulations? Are the rabbits bigger or 
smaller? 

 
 
 
 
 
 
 
 

 Why does the Forage Attraction Layer for the rabbits change dramatically after 
February 7th? What happens on February 8th? 
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